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Disclaimer
This document and its contents are the property of SOPHiA GENETICS SA and its affiliates
("SOPHiA GENETICS") and are intended solely for the contractual use by its customer in connection with the
use of the product(s) described herein and for no other purpose. This document and its contents shall not be
used or distributed for any other purpose and/or otherwise communicated, disclosed, or reproduced, or
referenced to in any way whatsoever without the prior written consent of SOPHiA GENETICS.
SOPHiA GENETICS does not convey any license under its patent, trademark, copyright, or common-law rights
nor similar rights of any third parties by this document. The instructions in this document must be strictly and
explicitly followed by qualified and adequately trained personnel to ensure the proper and safe use of the
product(s) described herein. All of the contents of this document must be fully read and understood before
using such product(s).

FAILURE TO COMPLETELY READ AND EXPLICITLY FOLLOW ALL OF THE INSTRUCTIONS CONTAINED HEREIN
MAY RESULT IN DAMAGE TO THE PRODUCT(S), INJURY TO PERSONS, INCLUDING TO USERS OR OTHERS,
AND DAMAGE TO OTHER PROPERTY.

SOPHiA GENETICS DOES NOT ASSUME ANY LIABILITY ARISING OUT OF THE IMPROPER USE OF THE
PRODUCT(S) DESCRIBED HEREIN (INCLUDING PARTS THEREOF OR SOFTWARE).

Trademarks
SOPHiA GENETICSTM and AlamutTM are trademarks of SOPHiA GENETICS SA and/or its affiliate(s) in the U.S.
and/or other countries. All other names, logos, and other trademarks are the property of their respective
owners. Unless specifically identified as such, SOPHiA GENETICS' use of third-party trademarks does not
indicate any relationship, sponsorship, or endorsement between SOPHIA GENETICS and the owners of these
trademarks. Any references by SOPHiA GENETICS to third party trademarks are to identify the corresponding
third-party goods and/or services and shall be considered nominative fair use under the trademark law.
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 Product Description 

Alamut® Visual Plus is a comprehensive genome browser compliant with HGVS nomenclature and 

powered by multiple genomic sources and prediction tools displayed in an interactive interface to 

ease variant interpretation.  

Alamut® Visual Plus is an upgrade of Alamut® Visual.  

 

 Intended Use/Purpose 

 Intended Use 

Alamut® Visual Plus is a Research Use Only software that eases daily genetic analysis. Alamut 
Visual Plus allows the visualisation of variants, transcripts, genomic sequences and genomic data 
to simplify variant interpretation and pathogenicity assessment. 
 

 Intended User Profile 

The application is intended to be used by trained medical professionals (clinicians, researchers, 

research technicians, …) working in the field of Genomics. 

 

 Intended Use Environment 

The place of use is determined to be in a hospital, labs or clinical setting, on a regular computer. 

 

 General Statement of the Test Principle(s) / Procedure 

Alamut® Visual Plus general procedure is as follows: 

• Display of a genomic region 

• Access to multiple public genomic sources and call prediction tools  

• Search for specific genomic data (genes, transcripts, variants) 

• Manual creation of genomic variants 

• Import and export of private variant annotations 

• Reporting of variant data  
 

 Product Components 

The product is only composed of the Alamut® Visual Plus software.  

Alamut® Visual Plus is installed with a floating license. Floating licenses can be installed on 
multiple computers, with a limited number of concurrent users and are managed via a web page 
(extranet). 
Alamut® Visual Plus extranet page: http://extranet.interactive-biosoftware.com. 

 

 
 

  

http://extranet.interactive-biosoftware.com/
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 Specifications and Installation 

  Specifications 

Alamut® Visual Plus is designed to be used on computers with a keyboard and mouse.  
Alamut Visual Plus is meant to be installed on computers meeting the following  
technical specifications: 
 

System Component Minimum Requirement 

Operating system 

Microsoft Windows 10, 64-bit version 
The program is available as an installer program (.exe) or self-
extractable archive (.exe) or compressed file (.zip) 
 
Mac OS X- starting from Mac OS 10.14 (Mojave) 

Internet Connection 

Connection to the following IP addresses are required: 

• 62.210.147.42 

• 212.83.147.70 
The software handles connections through HTTP/HTTPS on port 80 and 
443, optionally through a proxy server. 

Hardware Requirements 

Computer: 1.5GHz+ – 8GB RAM – 500MB free disk space. 
Display screen resolution: 1024x768 pixels 
The software program does not alter system directories or the 
registry. Write permissions are required on the software directory to 
ensure continued functioning of the application and to save user 
parameters. 

 
 

  Installation 

Once the Administrator’s credentials have been created, the Administrator must log-on to the 
Alamut® Visual Plus extranet page and create a new user account through the “Add user” button. 
 
 

 
 
The new user will receive the Institution ID, User Name and Password via e-mail. 
In order to install the program, the new user has to open the Alamut® Visual Plus extranet page and 
sign in with the Institution ID, User Name and Password provided. 
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Alamut® Visual Plus binaries can be downloaded from the “Downloads” section. 
 

 
 
Installation instructions depend on the computer’s operating system. 
 

Microsoft Windows  

Download the Alamut® Visual Plus Installer or Self-Extractable executable (.exe) from 

our extranet page: http://extranet.interactive-biosoftware.com. 

 
- If you have downloaded the Installer: execute it and choose an installation folder where you 

have write permissions 
- If you have downloaded the Self-Extractable executable (.exe) file, simply double-click on the 

installer to launch the installation program and follow the instructions presented to you. Select a 
folder where you have write permissions. 

 

http://extranet.interactive-biosoftware.com/
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After you have finished installing the program you should remove the files used for the installation: the 
Installer file or the Self-Extractable executable (.exe) file. 

 

Mac OS X 

Download the Alamut® Visual Plus (.dmg) file from the extranet page: http://extranet.interactive-
biosoftware.com.  

 

• double click the DMG to make its content available 

• drag the application from the .dmg window into /Applications to install (may need an 
administrator password) 

• wait for the copy process to finish 

• eject the .dmg (by clicking the eject button in the Sidebar) 

• delete the .dmg from Downloads 

 

 

 Post installation 

Once Alamut® Visual Plus is installed, you must set it up. Launch Alamut® Visual Plus and: 
 

1. Define the application’s data folder, where Alamut® Visual Plus will store its settings. You 
may decide to reuse an existing folder created by an older version of Alamut® Visual Plus: 
in this case, saved settings will be restored.  

 
 
 
 
 
 
 
 
 
 
 
 
 

http://extranet.interactive-biosoftware.com/
http://extranet.interactive-biosoftware.com/
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2. Accept the End User License Agreement. 
 

 
 
 

3. Provide 
a. Your institution code and your license key 
b. If any, information relating to your proxy server 

 
 
 
These 3 steps have to be followed at the first launch only.  
 
Once completed, users will only have to provide their username and password to connect to the 
application. The password will be renewed by the user every 90 days. 
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 Storage and Handling 

 Storage 

Not applicable. 
 

 Handling 

Not applicable. 
 
 

 Warnings, Limitations and Precautions 

For Research Use Only. Not for use in diagnostic procedures. 
Alamut® Visual Plus does not provide recommendations for medical diagnosis. It must be used by 
human genetics professionals and with critical judgment. SOPHiA GENETICS does not guarantee 
the accuracy of information and predictions it provides. 
 

 Residual Risks 

No residual risk has been identified as part of Alamut Visual Plus risk assessment.  
 

 Equipment and Materials Required, Not Provided 

The user needs to provide a computer, a keyboard, a mouse and an internet connection 
according to section 5 of this user guide. 

 User Manual 

 Support 

To get support for Alamut® Visual Plus, you can contact us by: 
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• clicking on Help on the Alamut® Visual Plus menu: Contact Support 

• sending directly an email to the Technical Support team using the following email 
address: support@sophiagenetics.com 

 
 Getting started: settings 

The Application Settings window includes the following tabs: License, Network, View, Misc. 
(Miscellaneous) 
 
License 

 

Institution: the code of the institution that 
purchased the license 
 
License Key: the license key of the 
institution 
 
User Name: the name of the connected 
user 
 
Language: Select your preferred 
language (English or French). 
 
Application: Tick the box to 
automatically check for updates. 

 
 
Click Save before leaving the tab. These details will be saved for future log-ins. 
 
 
Network 

To connect via proxy complete the necessary information in the Network tab (this may require the 
input of your IT  administrator).  
 

 
Use Proxy: To use a proxy server, tick the 
Use Proxy box and provide the required 
information to connect to it. 

 

mailto:support@sophiagenetics.com
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View 

The View tab in the Application Settings window is where you can modify the configuration of the 
tracks (displayed tracks and their positions) and define which filters apply to each track.  
 

Show Selected Transcript on Variant Tracks:  
select to view the selected transcript on the 
tracks. 
 
 
Default Genome Build (GRCh37 or GRCh38): 
select which genome build you would like to 
use by default. 
 
Configuration: it allows you to create a 
customizable view by adding or deleting the 
tracks that you want to see or hide. You may 
also reorder tracks via drag&drop. 
 
By clicking in ‘New’ you can create a new 
view configuration. In the Default 
configuration, all tracks are displayed.  

 

 
 

Note: configuration of tracks only applies to views where a transcript is selected. 
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Miscellaneous 

 

Mouse Wheel: two mouse scroll options are 
available to define the behaviour of the 
application when using only the mouse wheel 
or the mouse wheel in combination with the 
CTRL key. 
 
CRAM Settings: CRAM handling in Alamut is 
based on Samtools. Samtools needs the 
reference genome sequence in order to decode 
a CRAM file. Samtools can use either the 
REF_PATH or REF_CACHE environment 
variables to find reference sequences. (see 
below) 

 
 

 

 
Samtools needs the reference genome sequence in order to decode a CRAM file. It uses the MD5 
sum of each reference sequence as the key to link a CRAM file to the reference genome used to 
generate it (see also the Samtools man page). You will need to provide the path to MD5 reference 
sequences in the REF_PATH or REF_CACHE field, unless you use CRAM files with embedded 
reference sequences. 
For your convenience we have prepared a package of reference MD5 files for GRCh37 and GRCh38 
primary sequences. It is available at:  
http://downloads.interactive-biosoftware.com/CRAM/RefCache.tgz  
 
For instance, if you uncompress this file to the D:\SAM folder under Windows, the REF_CACHE 
should be:  D:\SAM\RefCache\%2s\%2s\%s 
 
 

 Manual update 

If you wish to update the application manually please follow these steps. Connect to our extranet 
page (http://extranet.interactive-biosoftware.com), select the downloads section and if available 
download the latest version. 

 

http://www.htslib.org/doc/samtools.html
http://downloads.interactive-biosoftware.com/CRAM/RefCache.tgz
http://extranet.interactive-biosoftware.com/
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• Or click on the “Update” button in the left part of the Alamut® Visual Plus 

homepage  
 

 Dashboard  

 

From the homepage you can open a gene, a genome assembly (GRCh37, GRCh38 or the 
mitochondrial genome) or directly perform a search (extended access feature).  
 

 
 

 

From the Open Gene menu, the user can type a gene symbol and open it in Alamut® Visual Plus. 
He may also use shortcuts. These shortcuts are totally configurable. 

 
 

10.4.1. Genomic Views (GRCh37, GRCh38 and mitochondrial view) 

The Genomic Views allow you to visualize all chromosomes including the mitochondria. You can 
visualize intergenic genomic regions, regulatory regions and structural variants.  

 

You can select the chromosome you wish to study, by double clicking on it. The overview of the 
selected chromosome will open. You can select a specific chromosomic region and zoom in to 
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view the genes available in the selected band. Genes are displayed with named tags along the 
strand.  

 

 
 

10.4.2. Overview of transcript 

 

You can have access to the transcript view from: 
1. the genomic views, by clicking on your gene of interest. You can display all transcripts 

related to one gene. The name of the transcript will be displayed in the transcript box.  
 
 
 
 
 
 
 
 
 
 
 

2. the ‘Open gene’ button in the homepage where you can select your gene of interest and 
then your transcript. The transcript of your selected gene is displayed in the overview, 
with the exons in blue and introns in yellow.  
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Notes 

- The reading direction of the gene (i.e the DNA strand) can be changed by using the 
forward direction and reverse direction icons on the toolbar. 

- The transcript and exon naming (if both Systematic and Custom naming are available for 
this transcript) can be modified interactively.  

- The view configuration can be modified. You can use different View configurations in 
different tabs. 

- Multiple tabs can be opened showing different genes/transcripts.  
- It is also possible to display all available transcripts simultaneously. 

 
Several transcripts can be shown in the interface by exploring options in the transcript track by 
right clicking on the gene name. 
 

 
 

Click on an exon number in the gene overview to zoom in directly and see the nucleotide 
sequence. 
 

 
 

Note: Mismatches between transcript and reference genome sequences can be found. Transcript 
nucleotides are highlighted in red where they differ from the reference genome sequence and the 
tooltip gives a warning message. 
 

 
 

 
 
10.4.3. Search bar (Extended Access Feature) 

 
Alamut® Visual Plus provides a search bar allowing to access: 
 

Standard Genetic References  

    

Reference Example 

Official HGNC gene symbol MLH1 

HGNC Id HGNC:7127 

cDNA RefSeq Id NM_000249.3 
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Ensembl Transcript Id (mapped to a NCBI RefSeq) ENST00000231790 

LRG Id LRG_1 

Protein RefSeq Id NP_000240.1 

UniProt Id P40692 

Reference SNP Id rs63750891 

OMIM Id OMIM:120436 

 
 

 

Genomic, cDNA and protein positions 
 

Reference Example 

Standard gDNA query chr3:g.37050315 

Short gDNA query 3:37050315 

Interval gDNA query  3:36000000-38000000 

gDNA query inside current gene g.37050315 

gDNA query with assembly chr3(GRCh37):g.37059038 

cDNA position query NM_000249.3:c.464 

Short cDNA position query NM_000249.3:464 

cDNA position query on Ensembl Trancript Id 
(mapped to a NCBI RefSeq 

ENST00000231790:c.464 

NM_000249.3:p.155 NM_000249.3:p.155 

Protein substitution  NM_000249.3:p.Leu155Arg 

 
 

Genomic and cDNA variants 
 

Reference Example 

Query with genomic variation chr3:g.37050315T>G 

Short query with genomic variation 3:37050315T>G 

Use given assembly Chr3(GRCh37):g.37067317G>A 

cDNA variant NM_000249.3:c.464T>G 

cDNA variant on Ensembl Trancript Id 
(mapped to a NCBI RefSeq) 

ENST00000231790:c.464T>G 
 

 
 
 
Depending on the query type, Alamut® Visual Plus may: 
 

a. Open a gene and one of its transcripts  
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b. Open a transcript selection dialog 
 

 
 

c. Open the variant panel 
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d. Directly focus to a genomic location 
 

 
 
10.4.4. “Focus on” feature 

 
Another feature ‘Focus on’ allows you to search for genomic coordinates and more. This feature 
is available from the “View > Focus on” menu. 
 
 

 
 
This functionality allows the user to easily and quickly find a: 

• genomic region 

• genomic position 

• cDNA position 

• protein position 

• variation 

• nucleic sequence 

• protein sequence 
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 Data sources 

 

To view the up-to-date list of data sources integrated into Alamut® Visual Plus, go to “Help > 
Data Sources”. Database versions of each source is also available here.  
 

 
 
By default, all data sources are selected and displayed. You can enable or disable manually 
these data sources in each view configuration in “Settings > View”. 
 
10.5.1. Population frequencies databases 

 
Alamut® Visual provides a convenient access to several databases of known variants. 
Population frequencies data is displayed in one track: ‘Allele Frequency Databases’. 
 
You can configure your track by clicking on the ‘Options’ button. You can select or deselect data 
sources and choose filters: 
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Hovering one variant will show information from different databases when available. Right 
clicking on a variant opens the official website of the selected source. 
 

          
 
More information from external databases is available in Alamut® Visual Plus by right clicking and 
selecting the variant’s gnomen: 
 

 
 
The variant panel will pop-up with more information in the ‘External databases’ section: 
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10.5.2. Clinvar 

 
Alamut® Visual Plus displays ClinVar variants in a dedicated track 
Variant background colors are based on the clinical significance provided by ClinVar submitters.  
 

• Red for pathogenic variants 
• Orange for likely pathogenic variants 

https://sophiagenetics-my.sharepoint.com/personal/zachour_sophiagenetics_com/Documents/Genova-Relaunch/IFU/gnomAD
http://gnomad.broadinstitute.org/
http://evs.gs.washington.edu/EVS/
https://www.interactive-biosoftware.com/doc/alamut-visual/2.15/SNPs.html#hgvd
https://www.interactive-biosoftware.com/doc/alamut-visual/2.15/SNPs.html#gonl
http://www.nature.com/ng/journal/vaop/ncurrent/full/ng.3021.html
http://www.nature.com/ng/journal/vaop/ncurrent/full/ng.3021.html
http://www.nlgenome.nl/
https://www.ncbi.nlm.nih.gov/pubmed/24290377
https://www.ncbi.nlm.nih.gov/pubmed/24290377
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• Light Green for likely benign variants 
• Green for benign variants 
• Gray for variants of an uncertain significance 
• White for Unclassified variants 

 

If multiple SNVs are reported at the same position, a tooltip pops-up to show significance for both 
variants.  

 
 
By clicking on ‘Options’ button from the ClinVar track, you can filter variants based on ‘Review 
Status’.  

 

The Review status numbers are defined as follows: 

• 0 : No submitter provided an interpretation with assertion criteria (no assertion criteria 
provided), or no interpretation was provided (no assertion provided). 

• 1 : At least one submitter provided an interpretation with assertion criteria (criteria 
provided, single submitter) or multiple submitters provided assertion criteria but there 
are conflicting interpretations in which case the independent values are enumerated for 
clinical significance (criteria provided, conflicting interpretations). 

• 2 : Two or more submitters provided the same interpretation (criteria provided, multiple 
submitters, no conflicts) 

• 3 : Reviewed by expert panel. 
• 4 : Practice guideline. 

 
 
Right-clicking will show the link to the ClinVar website and to the Variant panel where information 
from ClinVar is displayed. 
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10.5.3. COSMIC 

 
Alamut® Visual provides access to COSMIC variant in a separate track. Clicking on the ‘Options’ 
button via the COSMIC track allow to filter based on the ‘Tissue’ criteria. 
 

 

 
 
 
 

https://www.ncbi.nlm.nih.gov/pubmed/24234437
https://www.ncbi.nlm.nih.gov/books/NBK174587/


 
 

 

 
ALAMUT VISUAL PLUS 

© SOPHiA GENETICS 2021. All rights reserved.    

FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

27 

 
 

 
 
Right clicking on a mutation opens the variant panel with information and directs you to the 
COSMIC website. 
 

 
 
The review status displayed in the variant panel are reported from COSMIC as following: 

• The status "NA": “Not specified”, “Variant of unknown origin”, “Previously observed” 

• The status “No”:  "Reported in another sample as germline", "Confirmed germline variant" 
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• The status “Yes”:  "Reported in another cancer sample as somatic", "Confirmed somatic 
variant"  

 
 

References 

• Forbes et al. The Catalogue of Somatic Mutations in Cancer (COSMIC). Curr Protoc Hum 
Genet. 2008 Apr;Chapter 10:Unit 10.11. 

• Forbes et al. COSMIC: mining complete cancer genomes in the Catalogue of Somatic 
Mutations in Cancer. Nucleic Acids Res. 2011 Jan;39(Database issue):D945-50 

10.5.4. UniProt 

The Protein Variant track displays variants set at protein level from UniProt. You can see the 
amino acid information and the disease involvement by hovering over a variant on the track. This 
information is also available in the variant panel. 
 

 
 
References 

• UniProt: a worldwide hub of protein knowledge Nucleic Acids Res. 47:D506-515 (2019) 
 
10.5.5. Protein Domain 

The Protein Domains track will display the domain information from InterPro (via Ensembl).  

 
 

10.5.6.DGV  
 
The track displays the structural variations in the genome via the DGV database.  

 
 

References 

• MacDonald JR, Ziman R, Yuen RK, Feuk L, Scherer SW. The database of genomic variants: 
a curated collection of structural variation in the human genome. Nucleic Acids Res. 2013 
Oct 29. PubMed PMID: 24174537 

 
10.5.7. Repeat masker 

 
The Repeat Masker track displays the repeat DNA regions identified by the Repeat Masker tool.  

The regions are displayed in accordance to their type.  

• SINEs  

• LINEs  

• DNA elements (DNA)  

• Simple Repetitions (Simple Repeat) 

https://www.ncbi.nlm.nih.gov/pubmed/18428421
https://www.ncbi.nlm.nih.gov/pubmed/18428421
http://nar.oxfordjournals.org/content/39/suppl_1/D945.long
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• Low Complexity 

• Satellite Elements (Satellite) 

• Small RNAs (RNA)  

• Not Classified (Unknown) 

• Other 
 

 
 

10.5.8. Orthologues alignments 

The Orthologues track displays protein orthologue alignments from the Ensembl database, ICAR 
or IBC (In-house). These alignments show the conservation of amino acids across different species.  
 

 
 
By default, orthologues aligned and displayed in Alamut® Visual are taken from the Ensembl 
Compara database. So far (March 2010), the only non-Ensembl-based alignments available were 
the manually-curated alignments of ATMNM_000051 and U82828, provided by Tavtigian et al. 
(2009) and BRCA1 NM_007294, provided by IARC with Align GVGD. 
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• We would like to express our thanks to the Genetic Cancer Susceptibility Group at IARC 
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• Tavtigian, SV., Greenblatt, MS., Lesueur, F., Byrnes, GB. (2008). In silico analysis of 
missense substitutions using sequence-alignment based methods. Hum Mutat.11 : 1327-36 

• Tavtigian, SV., Oefner, PJ., Babikyan, D. et al (2009). Rare, evolutionarily unlikely 
missense substitutions in ATM confer increased risk of breast cancer. Am J Hum Genet. 
85 : 427-46. 

• Deforche A., Blavier A. (2010). Systematic Building of Multiple Protein Alignments for 
Variant Interpretation Human Genome Meeting poster. 

 
10.5.9. Genomenon Mastermind 

 

Mastermind® by Genomenon® is a search engine with a comprehensive collection of genomic 
evidence and a user-friendly database. 
 
More information about Genomenon is available at https://www.genomenon.com/tutorials/  
Mastermind visualization can be activated in the “Settings > View” tab for each view 
configuration. 
Alamut® Visual Plus displays Mastermind variants in a dedicated track: Genomenon Mastermind 
Cited Variants Reference. Variants are reported from Cited Variants Reference (CVR), equivalent 
to a Variant Call Format (VCF) file. The CVR contains a count of articles associated with each 

http://www.ensembl.org/info/genome/compara/index.html
http://www.ensembl.org/info/genome/compara/index.html
http://agvgd.iarc.fr/
http://www.iarc.fr/en/research-groups/GCS/index.php
https://www.ncbi.nlm.nih.gov/pubmed/18951440
https://www.ncbi.nlm.nih.gov/pubmed/18951440
https://www.ncbi.nlm.nih.gov/pubmed/19781682
https://www.ncbi.nlm.nih.gov/pubmed/19781682
https://www.genomenon.com/tutorials/
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variant, along with a deep link into the related Mastermind UI. More information on CVR 
at https://www.genomenon.com/cvr/ 
 
If multiple SNVs are reported at the same position, a number indicating the substitutions occurring 
at this position. A pop-pup at the top of the position will display the different variations.  
Right-click on a variant to display links to the variant panel and to the Mastermind® website.  
A field in the variant panel displays the number of articles, including the three MMCNT values. 
 

Mouse over on a CVR variant to pop-up a tooltip displaying the gnomen and the three MMCNT 
values: 

• MMCNT1: cDNA-level exact matches 
The number of articles mentioning the variant at the nucleotide level in title/abstract or 
full-text. 

• MMCNT2: cDNA-level possible matches 
The number of articles with nucleotide-level (from 1) and protein-level matching with not 
specified cDNA-level change (articles could refer to this nucleotide-level variant but there 
is insufficient data to determine conclusively). 

• MMCNT3: same biological effect matches 
The number of articles citing any variant with the same biological effect as the 
considered variant. This includes MMCNT1 and MMCNT2 articles plus those with 
alternative cDNA-level variants that result in the same protein effect. 

 
 
 
 
 
 
 
 
 
 
 
 
 
10.5.10. ACMG-AMP standards and Guidelines  

ACMG-AMP Variant Interpretation Standards and Guidelines Support are available in Alamut® 
Visual Plus. The 2015 report from the American College of Medical Genetics and Genomics (ACMG) 
provides recommendations for the reporting and interpretation of sequence variants for Mendelian 
disorders in a clinical context (Richards et al., 2015. Genet Med 17:405–424). 
We provide automatic variant evidence based on external data available in Alamut database 
following guidance from Richards et al., 2015.  
 
The ACMG guidelines support is available in the Variant panel > ‘Annotation’ tab > ‘Pathogenicity 
Class’ section.The suggested classification is displayed under ‘ACMG standards and guidelines’.  
By clicking in ‘Show details’, the user has access to definitions of categories as reported in 
Richards et al., 2015.  

https://www.genomenon.com/cvr/
http://www.ncbi.nlm.nih.gov/pubmed/25741868
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The user can modify variant evidence based on the scientific context. The selected evidence will 
then be displayed in the variant panel. The suggested ACMG pathogenicity class is assessed based 
on selected evidence by the user.  
 

 
 
 
 
 
When data are not available in Alamut database to support an evidence, ‘Not available’ is 
displayed in the ‘Suggested’ field. 
A blank/empty evidence field indicates that Alamut Visual Plus does not support these ACMG 
criteria, as the data required to determine these ACMG criteria is not available within Alamut 
Visual Plus (such as experimental results etc). 
 
The final pathogenicity classification has to be defined by the user in the ‘User defined 
pathogenicity class’ section in the Variant panel. 
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 In silico predictions 

 

10.6.1. Splicing predictions 

 
Alamut® Visual Plus includes a splicing module integrating a number of prediction algorithms 
and splicing prediction data: 

• Splicing signals: 
SpliceSiteFinder-like (donor, acceptor, branchpoint) 
MaxEntScan (donor, acceptor) 
GeneSplicer (donor, acceptor) 
NNSPLICE (donor, acceptor) 
Known constitutive signals (donor, acceptor) 
Mercer et al. high-confidence branchpoints 

• Exonic Splicing Enhancers (ESE) binding site detection: 
ESEFinder 
RESCUE-ESE 
EX-SKIP 
 

The splicing module includes: 

• The variant annotation window with automatically computed splicing predictions at the 
nearest junction for MaxEntScan and SSF predictors. 

• The splicing prediction algorithm NNSPLICE from fruitfly.org partially integrated: it can be 
interrogated from Alamut® Visual Plus through the Internet and its results are displayed 
seamlessly in the graphical interface. 

• The splicing report that provides scores for each predictor in a tabular format.  
 

 
 
 
To open the splicing window, click on the 'Splicing’ tab in the variant panel: 

 

http://www.fruitfly.org/seq_tools/splice.html
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The window displays the reference (wild-type) and mutated sequences and predictions are 
reported above and under each one. Exons are drawn as blue boxes. 
Hits from SpliceSiteFinder-like, MaxEntScan, NNSPLICE and GeneSplicer are displayed as blue 
vertical bars for 5' (donor) sites, and as green vertical bars for 3' (acceptor) sites. The height of 
each bar is proportional to the maximum possible score computed by the corresponding algorithm. 
Known constitutive signals are displayed as small blue (5') or green (3') triangles, close to the 
sequence letters.  
Mercer et al. high-confidence branchpoints are displayed as red triangles in the Branch Points 
sub-track of the Reference Sequence. 

When moving the mouse over each vertical bar or triangle, a tooltip appears with the 
corresponding score. You can display score numbers for each hit bar by just clicking the bar itself. 
 

 

 
 
The region for which predictions are computed is centred on the position of the variant. You can 
navigate before and after this region by clicking and dragging the mouse. 
Use the “Options” menu to select which predictions to display and to modify thresholds. 
 
To reveal differences between wild-type and mutated scores, click on the 'Highlight 
Differences' button. Unchanged hits get dimmed, while scores are displayed beside those that 
differ. 
To reveal differences between wild-type and mutated scores, click on the 'Highlight 
Differences' button. Unchanged scores get dimmed, while score numbers are displayed beside 
those that differ. 
To display ESE predictions, click the "ESE Predictions" button. ESE hits from ESEfinder are 
displayed above each sequence, and RESCUE-ESE hexamers are drawn under them: 
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To launch the EX-SKIP tool, click the "EX-SKIP" button. The "EX-SKIP" button is displayed after 
clicking the "ESE predictions" button). The pre-filled web form of the EX-SKIP tool is displayed in 
a new window. Input sequences are created as follows by Alamut Visual Plus: only exonic 
sequences are taken into account with up to 30 exonic nucleotides before or after the variant 
position within the exon. 
 
To generate a tabular report of splicing signals predictions, click the 'Report' button. By right 
clicking on the report you can save it in your computer. The flanking region threshold can be set 
by the user. The default is fixed at 0. 
 
The user can select displayed splicing methods from the “Options” menu. Thresholds for splice 
site predictors can be saved as user-defined parameters.  
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Background on prediction methods: 
 
SpliceSiteFinder-like 
This method is based on position weight matrices computed from a set of human constitutive 
exon/intron junctions for donor (both GT and GC) and acceptor sites. 
Alamut® Visual Plus uses the matrix described by Zhang et al. (1998) for branch points and the 
algorithms described in Shapiro et al. (1987). 
 
MaxEntScan 
MaxEntScan is a method based on the Maximum Entropy principle, developed by the Burge Lab at 
MIT and described in Yeo et al., 2004. The MaxEntScan splice site datasets and algorithms are fully 
integrated inside Alamut® Visual Plus, with permission from Christopher Burge. 
Alamut® Visual Plus only reports scores from the Maximum Entropy Model. 
 
NNSPLICE 
NNPLICE (available at the Berkeley Drosophila Genome Project web site) is a prediction method 
based on neural networks (Reese et al. 1997). Although not fully integrated inside Alamut® Visual 
Plus, it is transparently queried from the software. 
Alamut® Visual Plus reports scores from NNSPLICE 0.9. 
 
GeneSplicer 
GeneSplicer is an Open Source software available from the University of Maryland CBCB. 
GeneSplicer combines several splice site detection techniques, among which Markov models 
(Pertea et al. 2001). 
 
 
 
Known constitutive signals 
Alamut® Visual Plus reports in the splicing module each occurrence of the 9-mers (3 exonic + 6 
intronic nucleotides) found in the donor subset of human constitutive exon/intron junctions, and 
each occurrence of the 6-mers (4 intronic + 2 exonic) found in the acceptor subset. Acceptor 6-
mers are reported only where at least 6 of the 8 upstream nucleotides are pyrimidines. 
 
Mercer et al. high-confidence branchpoints 
Using exoribonuclease digestion and targeted RNA-sequencing to enrich for sequences that 
traverse the lariat junction and, by split and inverted alignment, Mercer et al. (2015) identified 
59,359 high-confidence human branchpoints in >10,000 genes, thus providing a first map of 
splicing branchpoints in the human genome. 
 
ESEFinder 
The ESEFinder method computes putative binding sites for Exonic Splicing Enhancers (Cartegni 
et al., 2003). We have embedded the ESEFinder matrices (licensed from Cold Spring Harbor 
Laboratory) inside Alamut® Visual Plus so as to perform the same computation as that provided 
by the CSHL ESEFinder web site. 
 
RESCUE-ESE 
In the RESCUE-ESE approach, specific hexanucleotide sequences are identified as candidate ESEs 
(Fairbrother et al., 2002). The set of human hexamers available from the RESCUE-ESE web site is 

http://en.wikipedia.org/wiki/Position-specific_scoring_matrix
http://hollywood.mit.edu/burgelab/maxent/Xmaxentscan_scoreseq.html
http://genes.mit.edu/burgelab/
http://www.fruitfly.org/seq_tools/splice.html
http://www.cbcb.umd.edu/software/GeneSplicer/gene_spl.shtml
http://www.cbcb.umd.edu/
http://www.ncbi.nlm.nih.gov/pubmed/25561518
http://rulai.cshl.edu/cgi-bin/tools/ESE3/esefinder.cgi?process=home
https://www.genes.mit.edu/3xq99qd3uza99myyuxb62hg9t3xf85


 
 

 

 
ALAMUT VISUAL PLUS 

© SOPHiA GENETICS 2021. All rights reserved.    

FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

36 

embedded inside Alamut® Visual Plus. 
 
EX-SKIP 
EX-SKIP compares the ESE/ESS profile of a wild-type and a mutated allele to quickly determine 
which exonic variant has the highest chance to skip this exon. It calculates the total number of 
ESSs, ESEs and their ratio. Specifically, it computes the number of RESCUE-ESEs (Fairbrother et 
al., 2004; Fairbrother et al., 2002), FAS-ESSs (Wang et al., 2004), PESEs/PESSs (Zhang et al., 
2004), neighborhood inference (Stadler et al., 2006) and EIE/IIEs (Zhang et al., 2008) for each 
segment. 
The EX-SKIP tool is available, through the Alamut® Visual pre-filled form functionality, from the 
menu bar of the "Splicing Effects" window after displaying ESE predictions. 
 
Set of human constitutive exon/intron junctions 
We have gathered a set of human constitutive exon/intron junction sequences as follows. 10,728 
human mRNA sequences from the RefSeq database (as of Dec. 2007), with status 'reviewed', were 
mapped onto the human reference genome (NCBI 36). Based on this mapping, genomic exon/intron 
boundary sequences were extracted into separate subsets for donor and acceptor sites. 
With these sequences, we have built three position weight matrices: two matrices for donor sites 
(GT and GC sites), and one matrix for acceptor sites (AG sites). 
  
Sequence logos 
These sequence logos depict the position weight matrices used by the SpliceSiteFinder-like  
algorithm in Alamut® Visual Plus. 
 
 

http://ex-skip.img.cas.cz/
https://www.ncbi.nlm.nih.gov/RefSeq/
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10.6.2. Missense predictions  

 

Alamut® Visual Plus provides automatically computed missense predictions done by Align GVGD 
and SIFT, based on orthologues alignments (see section 10.5.8. Orthologues alignments).  
With the genome build GRCh38 available in Alamut® Visual Plus, some orthologues alignments 
coming from ENSEMBL Compara have been updated and may lead to different predictions that 
those described for the same genes/transcripts for GRCh37.  
Currently, automatically computed predictions are provided for Align GVGD, SIFT and 
MutationTaster. 

Automatically computed predictions are available in the variant panel. Polyphen2 scores are not 
automatically computed.  

Clicking on the predictor name will bring you to the missense predictor website. 

 

 

 
 

 

This section describes how automatically computed missense predictions are provided in Alamut® 
Visual Plus: 
 
Align GVGD 
Align GVGD predictions are computed using the orthologue alignment provided by Alamut® Visual 
Plus for the gene under study (See section 10.5.8. Orthologues alignments). 
Align GVGD scores interpretation are available here. 

https://www.ncbi.nlm.nih.gov/pubmed/11222768
https://www.ncbi.nlm.nih.gov/pubmed/21309043
https://www.ncbi.nlm.nih.gov/pubmed/21309043
https://www.ncbi.nlm.nih.gov/pubmed/9278062
https://www.ncbi.nlm.nih.gov/pubmed/3658675
https://www.ncbi.nlm.nih.gov/pubmed/3658675
https://www.ncbi.nlm.nih.gov/pubmed/15285897
https://www.ncbi.nlm.nih.gov/pubmed/15285897
https://www.ncbi.nlm.nih.gov/pubmed/9536098
http://agvgd.hci.utah.edu/about.php
http://sift.bii.a-star.edu.sg/
http://www.mutationtaster.org/
http://agvgd.hci.utah.edu/classifiers.php
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Current version for precomputed predictions: Align GVGD Tavtigian et al. (2006) 
 
SIFT 
SIFT predictions are computed using the orthologue alignment provided by Alamut® Visual Plus 
for the gene under study. See SIFT Aligned Sequences. 
SIFT scores interpretation are available here. 
Current version for precomputed predictions: SIFT 6.2.0 
 
MutationTaster 
MutationTaster predictions are computed using the mapping between NCBI RefSeq and Ensembl 
Transcript Ids available in Alamut® Visual plus. 
MutationTaster scores interpretation are available here. 
Current version for precomputed predictions: MutationTaster2 from MutationTaster website 
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 Managing variants  

10.7.1. Entering variants  

 
Local Variant database 
Alamut® Visual Plus allows you to annotate and store variants handled through the software. 
Click on menu > Variant > Local Variant Databases. 

 

 

 
By default, a local database called “Alamut” is available, you can use it to store your internal 
variants. By selecting the ‘Display in track’ checkbox, you will be able to see your Local Variant 
Database and its variants in a separate new track in the interface. From the ‘Display in track’ 

http://sift.bii.a-star.edu.sg/www/SIFT_aligned_seqs_submit.html
http://sift.bii.a-star.edu.sg/www/SIFT_help.html#SIFT_OUTPUT_SUBST
http://www.mutationtaster.org/info/documentation.html#bayes
http://www.mutationtaster.org/
http://www.ngrl.org.uk/Manchester/page/MSAs
https://www.ncbi.nlm.nih.gov/pubmed/16014699
https://www.ncbi.nlm.nih.gov/pubmed/16014699
https://www.ncbi.nlm.nih.gov/pubmed/11337480
https://www.ncbi.nlm.nih.gov/pubmed/20354512
https://www.ncbi.nlm.nih.gov/pubmed/20676075
https://www.ncbi.nlm.nih.gov/pubmed/20676075
http://www.iarc.fr/en/research-groups/GCS/index.php
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check box, you can select the ‘View configuration’ where you can see the new track. You can see 
several Local Variant Databases at one time.  
 

 

 
By clicking in ‘New’ in the Local Variant Databases, a new tab will appear ‘New Database’. You 
can define a new database by selecting a path, adding a name and a description.  
You can easily switch from one database to another. 
 
The basic variant database functionality implementation allows to store databases on each user's 
computer, or on a shared folder. When variants are stored in a shared file system, caution must 
be taken so that two people don't edit concurrently variants. 
 

 

 

Alamut® Visual Plus enables also to list and navigate easily through all internal variants for the 
current gene by selecting a database and clicking in ‘Explore/Export’ button in the ‘Local Variant 
Databases’ tab.  
 
Variants will be displayed in a new tab ‘Variant exporter’. You can display different options as 
showed in the ‘Row filters’ and ‘Column filters’ fields. You can scroll down/up and right/left to 
explore your internal variants. 
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Creating a variant 
 
You can manually create variants either from the 'Variants' menu, or from a nucleotide selection 
in the genome or transcript track and its associated context menu (by right-clicking inside the 
selection). 
 
 
 

        
 
Once you have specified variant basic properties (position and type of change), the ‘Variant 
Panel’ (annotation window) opens in a new tab. In the ’Variant properties’ you can choose to 
apply your variant at the genome or transcript level.  
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Notes : Application of HGVS recommendations 

- Alamut® Visual Plus allows you to check in one click your variant with Mutalyzer Name 
Checker or VariantValidator from the annotation window 

- The HGVS recommendations for the description of sequence variants implies that for all 
descriptions the most 3' position possible is arbitrarily assigned to have been changed. 
Application of this recommendation can make variant entering in Alamut® Visual Plus 
sometimes disconcerting, since entering a variant may result in a variant located at a 
different position. The point is that both mutated sequences – entered and resulted – are 
identical. 

- The 3’ rule is applied at the genome level. So it is indicated the most 3’ position possible 
according to the forward sequence, and at the cDNA level so it is indicated the most 3’ 
position possible according to the transcript. Thus, in reverse strand, the cDNA-level 
variant positions do not always map to the same genome-level positions (this is no 
compliant with HGVS (For Alamut Visual users: this is handled differently as compared to 
Visual. In the Variant Panel > Variant Features > Genomic Level >  alternatively; it is 
indicated the HGVS nomenclature as referred to Visual) 

 

 
 
In the ‘Variant Panel’, you can find 5 sub tabs: 

1. Annotation. Provide the external annotation of a variant (see section 10.5, for each 
catalog description) 

2. Splicing. Provides splicing predictions scores (see section “10.6.1. Splicing predictions” 
for more details) 

3. Occurrences. You can record different occurrences of the same variant. To create an 
occurrence, in the ‘Occurrences’ sub-tab, click on the 'New Occurrence' button. In the 
‘Edit Occurrence’ tab panel, you can then enter specific information about the 
Occurrence. Fields RNA Analysis, Phenotype and Comment are enabled. 

 

 

https://mutalyzer.nl/
https://variantvalidator.org/
http://varnomen.hgvs.org/recommendations/general/
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By clicking in the ‘see HPO’ button. You can select a phenotype for your occurrence as 
referred to the HPO. A link to the HPO website is also provide. By double clicking on a 
phenotype, the selection field will be filled in.  The HPO-IDs will be reported in the final 
‘Occurrences’ sub-tab.    

 

 
 
 
The entered information related to the occurrence are shown in a table in the 
‘Occurrences’ sub-tab.  
You can then manage your occurrences by deleting, editing or adding existing 
occurrences: 
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4. Variants history. Provides a history related to a same variant when updates are provided. 

The variant history includes the ‘Date’, the ‘User’, the final pathogenicity ‘Classification’ 
and the Notes as written in the ‘Annotation sub-tab.  

 

 
 

5. Report. Report the investigation related to one variant (See section 10.7.4. Reporting 
Variants) 

 
 
Finally, you can save your created variant.  
You can choose to modify your ‘Transcript’ and ‘Local Variant Database’ using the menu on the 
Top of the ‘Variant Panel’: 

 
 

 
 
Note: In a same Local Variant Database, you cannot save same variant with different transcripts. 
 
Variants are graphically displayed in tracks based on the Local Variant Database where the variant 
is saved (See.10.7.1. Entering variants). The color of variant graphic items depends on 
pathogenicity annotations. By default:  

• Unclassified (gray),  

• Benign (dark green),  

• Likely benign (light green), 

• Uncertain significance (blue),  

• Likely pathogenic (Orange)  

• Pathogenic (red).  
 
10.7.2. Importing variants 

 
Supported file format 
Alamut® Visual Plus can import variant from external sources to populate the Local Variant 
Database. The imported file will be affected to the selected LVD. 
 
When variants are successfully imported, they are saved as standard Alamut® Visual Plus internal 
variants and can then be handled like other internal variants. 
Alamut® Visual Plus can import variant annotations from TSV (Tab-separated values) formatted 
files as Variant Calling Format files (VCF). 

http://www.1000genomes.org/wiki/Analysis/Variant%20Call%20Format/vcf-variant-call-format-version-41
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Note that for Alamut® Visual users, the same workflow can be used to import .mut files and 
.txt variants files that may have been exported from Alamut® Visual. 
 

TSV format 
 
Alamut® Visual Plus accepts a tabular import file containing variant descriptions and annotations. 
Import files must follow a precise format that is most easily created using a spreadsheet 
application like Excel. Here is an example. The column order must be strictly observed.  
 
The header line (with column labels) is mandatory. Columns must be named as in the example in 
below: 
 

 
 

The following sets of columns must be populated in order to define the variants: 
 

• Assembly 

• Chromosome 

• gNomen 

or 

• Gene 

• Transcript 

• cNomen 

 
Assembly — GRCh37 or GRCh38. 
Chromosome — chrN or N, where N is the number of the chromosome (or X or Y, or MT) 
Gene — The official symbol of the gene carrying the variant. 
Transcript — The RefSeqDna of the transcript used to describe the variant.  
gNomen — The gDNA-level variant description, using the HGVS nomenclature.  
cNomen — The cDNA-level variant description, using the HGVS nomenclature.  
Type — The variant type: Substitution, Deletion, Insertion or Duplication 
pNomen — Consequence of the variant at the protein level 
Coding Effect — Missense, Start loss, Nonsense, Stop loss, Frameshift, In-frame or Synonymous 
Evidences (ACMG) — ACMG evidence, separated by coma. 
Classification — The variant classification:  

• Benign 

• Likely Benign 

• Uncertain Significance 

• Likely Pathogenic 

• Pathogenic 

• Undefined Significance 
If no value is supplied here, " Undefined Significance" is assumed 
Notes — Comments associated to the variant. Free content field. 
Occurrence ID — Free content field. 
Family ID — Free content field. 
Phenotype — Free content field. 
RNA Analysis — Free content field. 
HPO IDs — Human phenotype ontology IDs 
Comment — Comment associated to the occurrence. Free content field. 
 
 
 

Assembly Chromosome Gene Transcript gNomen cNomen Type pNomen Coding effect Evidences (ACMG) Classification Notes Occurrence ID Family ID Phenotype RNA Analysis HPO IDs Comment

GRCh37 2 MSH2 NM_000251.2 g.47630335C>A c.5C>A Substitution p.(Ala2Glu) Missense PM1,PM2,PP3 Likely Benign This is a note relating to this variant 1 123 Adam+

GRCh37 2 MSH2 NM_000251.2 g.47630347_47630350del c.17_20del Deletion p.(Lys6Argfs*57) Frameshift Likely Pathogenic 2 456

GRCh37 2 MSH2 NM_000251.2 g.47657084A>C c.1276+4A>C Substitution p.? Undefined Significance
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VCF format 
 

Standard VCF files can be imported. Fields are #CHROM POS ID REF ALT QUAL FILTER INFO FORMAT 
Only CHROM, POS, REF and ALT are used to set up the variant. 
 
The import process 
To import variants from an import file as described above, in Alamut® Visual Plus:  Menu 
> 'Variants' > ‘Local Variants Databases'. Select a line (Local Variant Database) where the 
variants will be stored and specify the import file you have by clicking on ‘Import’.  
 

 

 

 
 
Alamut® Visual Plus will analyse the imported file and reports valid and invalid entries based on 
the format.  
 
Only validated variants (shown in green) will be imported to the Local Variant Database. Here is 
an example:  

 
 
 
 
Notes: 

- The import process can be managed without opening a specific gene or transcript from the 
homepage of Alamut® Visual Plus 

- The import process can also be managed when a gene and a transcript are already selected 
and opened.  

- For VCF and TSV (with gNomen) import files, variants outside of the gene locus will also be 
processed. 

- To visualize variants in tracks, you need to open the appropriate gene and transcript. The 
‘Display track?’ in the Local Variant Databases tab should be selected (see section 10.7.1. 

Entering variants). 
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10.7.3. Exporting variants 

 
Export internal Variants 
To export variants already entered in Alamut® Visual Plus to Excel, to tab-delimited text files or 
to VCF, go to menu 'Variants' > 'Local Variants Databases' and Select the source Local Variant 
Database.  
The ‘Variant Exporter’ pops-up. Select options, fields you need to export and the folder where 
you need to save the exported variants.  

 
 

 

 
All grayed fields in the ‘Column filters’ are exported by default.  
 
Export Variants with external annotation 
For each variant entered in the software, Alamut® Visual Plus generates a set of annotations. 
Annotations are gathered for each variant and can be exported by ticking the “All annotations” 
checkbox.  

10.7.4. Reporting Variants 

You can create a final report including all information related to one specific variant. This 
functionality is available via the ‘Variant Panel’ > ‘Report’ sub-tab. 
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In the menu on the right, you can select features to display in the final report.  
By right clicking in the report, you can save the report in a PDF or HTML format. 
 

 
  Data visualization 

10.8.1. Viewing BAM/CRAM alignment files 

 
Alamut® Visual Plus allows to visualize alignment from BAM and CRAM files.  
 
     Loading BAM and CRAM files 

 
Two options are available to load alignment files once your gene of interest is opened: 
• Select menu "File > Open BAM/CRAM File" to load one or more BAM or CRAM files from your 

computer or local network. 
• Select menu " File > Open BAM from URL" to load a BAM file from a web server. HTTP and 

HTTPS protocols are supported. 
Using CRAM files usually requires defining the location of reference sequences. (See Miscellaneous) 
 
 

 

 

Note: One or multiple alignments can be loaded for one gene.  

 BAM Viewer components 

 The BAM track includes different components 

 



 
 

 

 
ALAMUT VISUAL PLUS 

© SOPHiA GENETICS 2021. All rights reserved.    

FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

49 

1. Sequencing targets 
2. Depth of coverage 
3. Reads 
4. Variants 

 
When zooming at nucleotide level the genomic reference sequence is displayed above the targets 
sub-track: 
 
 
 
 
 
 
 
 
Hovering a read will display information related to reads as indicated in the BAM file: 

 
 
Viewing sequencing targets 
In Alamut® Visual Plus, sequencing targets are supposed to cover current gene's exons with some 
exon-flanking intronic bases (20bp, by default):  
 
 
 
 
 
You can also load targeted regions from BED files in the BAM track. From the BAM track ‘Options’ 

  or by right clicking in the BAM track. Select "Load BED targets from file" to load a BED file 
from your computer or select "Load BED targets from URL" to load a BED file from a web server. 
HTTP and HTTPS protocols are supported. 
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Viewing variants 
Single nucleotide variants (SNVs) are automatically detected where non-reference bases are called 
at a frequency above the 'Allele frequency threshold' defined in the Preferences panel. Jump from 
one SNV to the other by clicking the arrow buttons on the left of the coverage sub-track. 
 

 
 
By default, the VCF is loaded when importing the BAM file if it is located in the same folder with 
same file name.  

From the BAM track ‘Options’   or by right clicking in the BAM track. Select "Load VCF variants 
from file" to load a BED file from your computer or select "Load VCF variants from URL" to load a 
BED file from a web server. HTTP and HTTPS protocols are supported. 
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Visualization options 

BAM preferences are accessible through the BAM track ‘Options’  or by right clicking in the 
BAM track. 
 
 
 

 
 
 

 
 
 

1. By default, sequencing targets are supposed to cover current gene's exons. This setting 
specifies the number of exon-flanking intronic bases to add to exon-defined targets.  

2. The coverage histogram can either be displayed using a linear scale where the height of 
each bar is directly proportionate to the depth value, or using a quadratic scale where 
low depth values are increased and high depth values are decreased. 

3. Targets are highlighted with red color where coverage depth is below this threshold. 
Besides, detected SNVs are only reported at positions where coverage is above this 
threshold. 
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4. Single nucleotide variants (SNVs) are detected where non-reference bases are called at a 
frequency above this threshold. 

5. These settings define the graphical height of reads. 
6. If 'Show all bases' is not checked then read bases are displayed only if they differ from the 

reference sequence. Some NGS data processing tools "soft-clip" bases at either end of 
reads if appropriate. Checking the 'Show clipped bases' option reveals these bases. This 
option should usually remain unchecked. 

7. Alamut® Visual Plus does not itself detect PCR duplicates. Reads marked as PCR 
duplicates in the BAM file are withdrawn if this option is checked. 

8. This setting only affects the graphical display of reads, not computations. 
9. Reads with a mapping quality under this threshold are withdrawn. 
10. If this option is checked then called bases with a Phred score under the specified 

minimum threshold are not displayed. Bases with a Phred score between the specified 
minimum and maximum thresholds are shaded. Bases above the maximum threshold are 
displayed in full color. 

11. Based on insert size values provided in the BAM file, paired reads too distant or too close 
from each other are highlighted if this option is checked. Expected normal insert sizes can 
be expressed as fixed values or as a percentage over the distribution. If the insert size is 
large, denoting a deletion, reads are colored red. If the insert size is small, denoting an 
insertion, reads are colored blue. 

 
Viewing BAM alignment statistics 
Alamut® Visual Plus computes descriptive statistics from BAM file (depth of coverage and insert 
size). These statistics are computed for the current displayed gene locus. 

Click on the picture (red histogram near options in the BAM track) and, then select either "Depth 
of Coverage" or "Insert Size Distribution" from the menu. 

 

 

 

 

To display the depth of coverage statistics, select "Depth of Coverage" from the menu. 
A table summarizes for the current gene locus, the following statistics: 

• Depth of coverage 1X: the percentage of a region that is covered by at least one read. 
• Depth of coverage based on a user defined coverage threshold: the percentage of a region 

that is covered by at least this coverage threshold. 
• Average, Median and Maximum of the depth of coverage. 
 
These statistics are computed for the following regions: 
• On-Target: targeted region (the region of interest that needs to be investigated by the 

sequence analysis)  
The region is based on the region defined by a user BED file or by the Alamut® Visual Plus 
targeted region (see ‘Viewing sequencing targets’ section for more details) 

• Off-Target: region outside the targeted region (not investigated by the sequence analysis) 
• Locus: current gene locus 
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To display “Insert Size Distribution" (only for paired-end sequencing data), select "Insert Size 
Distribution" from the menu. 
The insert sizes are computed from the reads that are in the current gene locus (displayed in 
Alamut® Visual Plus) and, then they are plotted as follows. 
The cutoff option allows to choose an insert size interactively displayed in the graph.  
 

  

10.8.2. Viewing Sanger electropherogram 

Alamut® Visual Plus allows you to upload Sanger Electropherogram (Sequencing) data by opening 
a new track through the “File > open Sanger file” menu. 
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A pop-up will appear where you can select the exon where the Sanger sequencing was performed: 
 

 
 
 
The Sanger track shows different components 
 

 
 

1. Quality scores displayed in bars. 
2. Reference sequence. Note that when the gene is reverse, the reverse reference sequence 

is displayed. 
3. Sanger reference. Note that when a substitution is detected, it is highlighted in red. A 

deletion is indicated by a ‘-‘and highlighted in red. An insertion is indicated by an arrow.  
4. Electropherogram. The display can be scaled with the ‘Scale’ button.  
5. The quality threshold. By default, the threshold is set at 20. The user can customize the 

threshold. When the shows a quality score inferior or equal to the indicated ‘Q-value’ in 
the track, the bar in the quality scores sub-track is displayed in orange. 

6. Print Sanger track 
 
When hovering the nucleotide in the Sanger track, you can see the nucleotide and its coordinates 
as following: 
 
 

 

 

 
10.8.3. Private Annotations 

Private annotations functionality enables the user to define manually and import sequence-
based annotations, such as BED files. This feature is available on a dedicated track. To switch 
this feature on, the corresponding track needs to be enabled from the settings View menu. 
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Customs Private Annotations 
 

Creating and managing private annotation databases 
 
Private annotations are stored in a dedicated database. To manage your private annotation 
databases, click on menu > Private Annotations > Private annotation Databases. 
 

 
 
The Private Annotation Databases window lists the existing databases. In the Private Annotations 
Track, you will be able to see the content of one of your Private Annotation Database. You can 
choose your current database by using the checkboxes in the ‘Current Database’ column.  
 

 
 
 
To create a new database, click on ‘New’ button. A new pop-up will appear. You can define a 
new database by selecting a path, adding a name and a description. 
 



 
 

 

 
ALAMUT VISUAL PLUS 

© SOPHiA GENETICS 2021. All rights reserved.    

FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

56 

 
 
The basic private annotation database functionality implementation allows to store databases on 
each user’s computer, or into a shared folder. When private annotations are stored in a shared 
file system, caution must be taken so that two people don’t edit concurrently private 
annotations. 
 

Creating and managing datasets 
 
Private annotations are organized in sub-tracks called datasets. To create custom datasets, you 

can use the ‘Options’ menu  of the Private Annotation Track or the context menu of a 
nucleotide selection in the Private Annotation Track (by right-clicking inside the selection).  
 

You need to have a database selected as your current private annotation database to 
be allowed to      create custom datasets. 

 

                
 
Clicking on ‘Add Dataset’ will open a new pop-up where you can specify the name of your new 
dataset. Dataset names have to be unique among a database. Clicking on ‘Ok’ will create the 
dataset and the new sub-track will appear. 
 

                              

 
 
 
Right-clicking on a dataset label will open a context menu. This context menu allows the 
following actions: 
 

- Transparency: the private annotations are displayed with semi-transparent colors when 
this option is checked and with plain colors otherwise  

- Hide: hide the dataset from the track 

- Hide Others: hide the other datasets from the track 
- Up: move up the dataset 
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- Down: move down the dataset 

- Rename: rename the dataset 
- Clear: delete all annotations of the dataset 
- Erase: delete the dataset (from the track and from the database) 

 

The ‘Options’ menu  of the Private Annotation Track contains items to manage the group of 
datasets: Show All to show all datasets when some have been hidden previously and Erase All to 
erase all the datasets. 
 
 
 

Creating and managing Private Annotations 
 
A new private annotation can be manually created from the context menu associated to a 
selection of nucleotides. The nucleotide selection can be done in the Private Annotation, the 
Genome or the Gene tracks.  
 

You need to have a database selected as your current private annotation database and 
to have at least one dataset in your current database to be allowed to create private 
annotations. 
 

 
 
Clicking on ‘Make sequence annotation…’ will open a new pop-up where you can specify the 
properties of your private annotation:  
 

- Dataset: the dataset/sub-track 

- Assembly: the assembly of the annotated sequence. A private annotation is visible only on 
the assembly its sequence belongs to. When updating the assembly, the positions From and 
To will be automatically mapped to the new assembly 

- From/To: origin and end of the annotation. The strand is automatically set according to 
the strand that has been used to select the nucleotides in the track. The length and the 
sequence are automatically computed. 

- Name: name of the private annotation. Private annotation names have to be unique among 
a dataset 

- Arrow: the arrow initialized according to the strand of the private annotation 

- Score 
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- Color 

- Comment 
- External link: web link or link to an internal document 

 

Clicking on ‘Save’ will create the private annotation and it will be visible in the sub-track it 
belongs to.  
 

 
 
Then, to edit the private annotation information, you can either double-click on the private 
annotation or use its context-menu. 
 

 

 

Import Private Annotations from Alamut Visual® 
 
Private Annotation files from Alamut® Visual (.apa) can be imported into the Private Annotation 

Databases of Alamut® Visual Plus. To do so, open the Private Annotation Database window via 

Menu > ‘Private Annotations’ > ‘Private Annotation Databases’. Select the database you want to 

import the private annotations into. Click on ‘Import’ and select the file you want to import.  
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Viewing sequence-based annotation files 
 
Alamut® Visual Plus supports the import of annotations in BED, GFF version 2/GTF and GFF 
version 3 formats into the Private Annotations Track.  
 

To import sequence-based annotation files, open the ‘Options’ menu  of the Private 
Annotation Track and click on ‘Import Files’. Choose the files you want to import and validate. 
You can import several files at once. 
 

 
 
Each file will generate at least one dataset and the sub-track will appear in the track. As for 
manually created datasets, right-clicking on a dataset label will open a context menu.  

 
 
 
This menu contains two items to manage how the private annotations are displayed in the 
associated sub-track: 

- Full: change the display in order to view all segments in full mode 
- Squish: change the display in order to view all segments in squish mode 

 
Data imported from sequence-based annotation files cannot be edited so a dataset created by 
an import cannot be renamed or erased.  
  
You can visualize the information of the imported private annotations by double-clicking on it or 
by using its context-menu. The information of imported private annotations cannot be edited. 
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 Alamut Visual Plus API 

Alamut® Visual Plus includes a programmatic access functionality through an Application 

Programming Interface (API) enabling external tools to control the software. Notably, the search 

bar is open to external software: any software tool or web page can be customized in order to 

request Alamut® Visual Plus to display any information that can be processed by the search bar. 

 
 

The server listens to local HTTP GET requests coming through the port that is specified in the 

Options dialog box (see above). The default port is set to 10000 but it can be changed to any 

available port in the Options dialog box (menu ‘Settings’ > ‘Network’ > ‘API’ section). 

 

 
 

10.9.1 Specifications 

 

Three HTTP GET requests can be processed by Alamut® Visual Plus: version, search and open.  

search and open require the user or the third-party software to provide its institution ID and API key. If 

you don’t have one yet, please contact support@sophiagenetics.com. 

10.9.2 Version 

http://127.0.0.1:10000/version 

Upon receiving this request, useful for testing purposes, Alamut® Visual Plus outputs its current 

version and name as a json object. 

10.9.3 Search 

http://127.0.0.1:10000/search?institution=XXXXXX&apikey=YYYYYYYY&request=NM_000059.3:c.4563A>C 

 

This request asks Alamut® Visual Plus to display any data available in the system (here variant 

“NM_000059.3:c.4563A>C”). Any request that can be processed by the search field of Alamut® 

Visual Plus (see 10.4.3. Search bar (Extended Access Feature)) can be processed with the “search” 

verb. 

mailto:support%40sophiagenetics.com
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10.9.4 Open 

http://127.0.0.1:10000/open?institution=XXXXXX&apikey=YYYYYYYY&filetype=bam&path=http%3A%2F%2Frd-

connect.interactive-biosoftware.com%2FBAM%2Fexample.bam 

 

This request asks Alamut® Visual Plus to open a BAM file located at http://rd-connect.interactive-

biosoftware.com/BAM/example.bam  (the path is percent encoded, see https://www.urlencoder.org). A 

gene or a genomic region has to be opened beforehand in this case via the search verb.  

The path to a local path should contain file:// as in the example below: 

http://127.0.0.1:10000/open?institution=XXXXXX&apikey=YYYYYYYY&filetype=bam&path=file%3A%2F%2F%2FUsers%2Ftoto%2

FMLH1%20grch37.bam 

This will open file:///Users/toto/MLH1 grch37.bam . 

The open API call supports BAM, CRAM and Sanger file types. 

A detailed description of the API can be found here: 

https://extranet.interactive-biosoftware.com/alamut-visual-plus_API.html 

 

 Miscellaneous 

Menus  

• Application 
o Open Gene 

o GRh37 
o GRh38 
o Mitochondrial view 
o Home 

• File 
o Open BAM/CRAM File 

o Open BAM from URL 

o Open Sanger File 

o Export Fasta Sequence 

• View 

o Focus on 

o Show ruler 

o Color nucleotides 

o Use amino acid 3 letter code 

o Full Screen 

o Show navigation bar 

o Increase Font 

o Decrease Font 

o Reset Font 

https://www.urlencoder.org/
https://extranet.interactive-biosoftware.com/alamut-visual-plus_API.html
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o Enter Full Screen 

• Web 

o View gene in Ensembl Browser  

o View displayed region in Ensembl Browser  
o View entire region in NCBI Sequence Viewer  
o View entire region in UCSC Browser  
o View HGNC symbol report for this gene  
o View gene in OMIM® web site  
o View gene in GENATLAS web site  
o View gene in Gene Reviews web site  
o View Uniprot entry for the product of this gene 

• Variant 
o New Variant 
o Local Variants Database 

• Tools 
o Genetic Code 
o Compare Amino Acids 
o Assembly Mapping 
o Take Screenshot 
o Nomenclature validation dialog 
o Variant validation dialog 

• Help 
o Software Documentation 
o Data Sources 
o License Agreement 
o Software Reference 
o Contact Support 

 
Navigation with keyboard 
Use the following keys to navigate in Alamut® Visual Plus:  

• Left arrow key: step shift the sequence to the left 

• Right arrow key: step shift the sequence to the right 

• Up arrow key: step shift the tracks upwards 

• Down arrow key: step shift the tracks downwards 
 
 

 Quality Control Procedures 

External genomic data has been successfully tested and implemented in Alamut database. 
Frontend functionalities and data display have been successfully tested and implemented 

 

 Other Information 

 
 Training 

 
Before using the Software, video tutorials are provided in the software homepage to get started. 
Further requests on live demo and support can be addressed to :  
support@sophiagenetics.com 
 

mailto:support@sophiagenetics.com
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 Responsibility 

This system solely provides assistance to the intended user and does not substitute or replace 
the intended user's experience and/or responsibility during its use. It must always be possible 
for the user to proceed without the assistance of the system.  

 Documentation 

This user manual describes the use of an interpretation software for genomic variations that 
must be used with care. It is therefore important that all users of the software:  

• Read this guide carefully before use  
• Have access to this guide at all times  

 

 Symbols 

 
 

User Manual, Operating instructions 

 

Read User Manual, Read Operating instructions 

 
Research Use Only 

 
 

 
Reference Number 
 

 
 

Manufacturer 

 
 

 Support 

 
In case of difficulty using the product, contact our support line and e-mail mentioned on the 
"Summary Information" page of this user guide. 



© SOPHiA GENETICS 2021. All rights reserved.
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